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Chapter 1: Installing the software

This chapter will explain how you can install the Dimmer Manager software and view the demo file.

Step 1: take your copy of the CDR, or download from the ADB website

Step 2:
• install the CDR in the CD drive
• if Auto-Install is enabled, go to step 4.
• if Auto-Install is disabled, proceed with step 3.

Step 3:
• double-click on the CD drive (or on the downloaded file)
• double-click on the folder Software
• double-click on DMRelease

Step 4: the following window will open

To install the software

• to install: click Start
to quit: click Exit and confirm (Yes)

To uninstall the software
The Installation includes an UnInstall tool.xà
WindowsStart > Programs > Dimmer Manager > Uninstall
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Chapter 2: Getting started – the demo version
This chapter will explain how you can view the demo version, and the first steps in working off-
line i.e. without a physical connection to ADB dimmers.

Starting the Dimmer Manager software

WindowsStart > Programs > Dimmer Manager (the folder) > Dimmer Manager (the programme).
This will open a window similar to:

This shows a sample installation with various types of dimmer units, groups, groups in groups,...
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Click on the + in the left top corner to expand the list of groups and dimmer units.

Off-line User Levels

You select the User Level in the lower left corner.

User Level 0 is limited to Viewing of all settings and parameters. Other functions are shaded i.e.
they’re not accessible.

Higher User Levels give access to more and more functions.

For OnLine user levels, a user name and password are required (see Changing the User Level
when Online).

Menu bar description

File :  files functions
Edit :  Edition functions
Dimmers : All functions on dimmers (creation, modifications, commands)
Parameters : log functions, languages
System-wide : memory play and record
Windows : all functions on windows (open, close,tile, …)
Help : help functions and “about”
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Exemples:
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From Dimmer manager V2.00, EURODIM Twin Tech is supported.
The functions in light grey in the menu are not yet developed for EURODIM Twin Tech.
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Chapter 3: the Edit Parameters functions

Edit Parameters covers functions which are global for the dimmer unit such as What if DMX fails,
priority between DMX and local cues, choice between Patch and House Patch,…

In OnLine mode, most parameters are already defined by the dimmer unit. This chapter covers
the user-defined parameters.
• select the dimmer unit
• Menu bar: Dimmers > Edit > Dimmer Parameters

This opens a dialogue window "Edit global dimmer parameters":

Some parameters are defined by the dimmer unit and cannot be edited: dimmer model, rating...

As a precautionary measure, the Mains Frequency and the Network Address can only be edited
on the dimmer unit itself, using the local menus.
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Name of the dimmer unit

The name will show up under the unit’s icon, in various lists (left hand column on main page).
Dimmer Manager automatically creates a name with the dimmer type and the Network Address.
You can edit that name.

NETPORT XT

Select the NETPORT XT to which the dimmer unit is connected. The pull-down list shows all
known NETPORT XT. Use Adding a NETPORT XT if necessary.

If DMX fails

Decides the action taken by the dimmer unit. For full details, see The Dimmer manual
"Programming Digital Dimmers and NETBUS"

Priority

HTP: when a local cue is played, the local cue is combined with incoming DMX values, on
a HTP (Highest Takes Precedence) basis.

Priority: while a local cue is played, the DMX is faded out (fade time 5 s) and the lighting levels
on stage are as defined in the local cue.

For full details, see The Dimmer manual "Programming Digital Dimmers and NETBUS"

Configuring the DMX A - Patch

Three addressing schemes are possible:
• set a Start Address; this will give automatic sequential numbering
• selecting the non-sequential Patch; Patch to be edited with the Edit Patch function
• selecting the House Patch; House Patch to be edited with the Edit Patch function

List of dimmers in the unit

On the right: all the dimmer in the unit, with their physical number in the unit, their Dimmer Name
- adding text to a dimmer, and their power rating.

Note: If you create a virtual dimmer unit in OffLine mode, then you must define all parameters
of the virtual unit: type, dimmer rating,… See Creating a virtual dimmer.
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Some new parameters has been added or changed. When the user creates an EURODIM Twin
Tech cabinet, the edit parameter window becomes :

Network configuration window is used to configure the 2 DMX lines on RS485 and the 3 DMX
on Ethernet lines (= 5 DMX sources).

Merging & DMX Fail rules window is used to configure merging rules and priority between the
5 DMX sources.

Power info window is used only by ADB to configure the modules type installed in the cabinet.
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Chapter 4: the Edit Patch functions

This chapter will describe a number of functions related to Patch, House Patch, Dimmer Law,
Dimmer Name, Smoothing…

For more details about these functions, we refer to the dimmer manual “Programming Digital
Dimmers and NETBUS”.

Getting to the Edit Patch functions

• select the dimmer units (or Groups) you want to Edit
• Menu Bar > Dimmers > Edit > Edit Patch

The Get and Send buttons

Opening “Edit Patch” and then clicking the Get button will download the current settings from the
dimmer unit to the Dimmer Manager PC. You will thus update the PC.

Opening Edit Patch and then clicking the Send button will send parameters to the dimmer units.
This will erase the old data in the dimmers.

Patch A

Patch A defines the DMX address (A input) for each dimmer.

Note: fast automatic numbering based on a "DMX start address" is also possible with the
Chapter 3: the Edit Parameters functions function.
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House Patch A
The House Patch A is a preferred patch, stored in the dimmer unit. The House Patch is edited in
Edit Patch and can be recalled with the Chapter 3: the Edit Dimmer Parameters functions
function.

Patch B and House Patch B
Patch B and House Patch B are standard in EURODIM 3 and are optional in EURORACK 60.

Dimmer Law
Each dimmer unit stores nine standard dimmer laws, and one custom law. The Dimmer Law
column shows/selects the dimmer law which is applied to that dimmer.

The Custom Law can be different for each dimmer unit; it is selected in Edit Dimmer Parameters.

You can copy settings from one dimmer unit to another

Select a Group, or select several dimmer units, and then select Edit Patch. Use the tabs (in this
example: Bottom, Mid, Top) to choose one of the selected units.

• select the tab of the "original" dimmer unit, select the cells you wish to copy

• right-click Copy

• select the tab of the target dimmer unit, and select the target cells

• right-click Paste
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Factor

The reduction Factor of a dimmer is similar to the function in a lighting console’s proportional
patch. FF indicates 100% (no reduction). Setting its factor to 0% will disable that dimmer (but it
will not disconnect it from the mains!). The Factor does not alter the shape of the dimmer law. The
Factor stored in a dimmer is out of reach for the console operator.

Smoothing

Smoothing refers to ADB software algorithms which convert the 8-bit DMX data (256 levels from
Off to Full) into 12-bit internal values (4096 levels from Off to Full). This gives noticeable smoother
fades, especially during slow changes. The default setting is Medium.
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Dimmer Name - adding text to a dimmer channel

You can add a brief text description to an individual dimmer. It appears in the column "Dimmer
Name". "Test a Channel" allows you to find and test a dimmer according to its name.

To edit the Dimmer Name
• Menu Bar > Dimmers > Edit > Edit Patch

In Edit Patch, enter an alpha-numerical text in the Dimmer Name column. Max. 6 characters.

Example of a Dimmer Name: the channel number
In that case the Dimmer Name matches the numbering on the outlets in the venue, and the
channel numbering in the console. This allows special outlet numbering schemes such as the use
of Channel Numbers up to 9999 in smaller dimmer systems.

Example of a Dimmer Name: the DMX address and the DMX universe
If you copy the DMX address into the Dimmer Name, then Test a Channel will give you direct
access to that dimmer, even if you don’t know its physical location in the dimmer racks.

To Copy the DMX Addresses from the Patch column to the Dimmer Name column:

• Menu Bar > Dimmers > Edit > Edit Patch

• select all the cells with DMX addresses

• right-click Copy

• select all the target cells of the Dimmer Name column

• right-click Paste; you can insert the letter for the DMX universe, if applicable

Example of a Dimmer Name: its position or function
This example shows dimmer names inspired by position (Downstage…) or type of lamp (Fluo…).

Note about Sorting by DMX address
When dimmers are sorted by DMX address, the digits are sorted like alphanumerical characters
(not like numbers). This is because Dimmer Manager is not a spreadsheet. A simple solution is
to use the Dimmer Name field and enter the DMX addresses in a three digit format: 001 instead
of 1. Sorting by Dimmer Name will then achieve the desired effect.
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The Edit Patch window for EURODIM Twin Tech is :
There are 10 patches : 2 patches (patch + house patch) by DMX source.

To change the “base address” for a DMX source, use the “change all line” :
1 Write the base address on the change all line
2 Click on the “send” button.
3 Answer “yes” to the update all rows
4 Click on the “OK” button
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Chapter 5: Getting started – the on-line version

This chapter will explain how you can establish communication between the Dimmer Manager
PC, a NETPORT XT and ADB dimmers.

IP settings

Off-line operation does not require particular IP settings. You can view *.dim files (such as the
sample file), edit them, create virtual systems,… without worrying about TCP/IP.

Once you go OnLine with dimmers, two numbering schemes are critical:
• the IP settings of the Dimmer Manager PC and other Ethernet nodes such as NETPORT XT
• the Network Addresses on the ADN network (EIA-485)

You will have to plan the IP addresses for all the TCP/IP devices connected to your Ethernet-for-
lighting network.

This is a simple task for a "Dimmer Manager only" Ethernet network: the devices include the
Dimmer Manager PC and one or several NETPORT XT (used as Ethernet/ADN converter).

A broader "lighting" network may additionally include lighting consoles using Ethernet (ADB’s
PHOENIX range,…), and Ethernet/DMX converters such as NETPORT and NETPORT XT.

If you’re not familiar with TCP/IP configuration, please ask a knowledgeable IT person. Also ask
him/her for advice if you would like to use the Dimmer Manager PC for other applications requiring
TCP/IP (e.g. a portable PC also used for Internet access).

Required IP settings for the PC

Please provide the following information to your friendly IT person:
• the Ethernet-for-lighting network should be independent of other Ethernet networks; any

connection to other networks should be evaluated with extreme care
• NETPORT XT uses 10BaseT and TCP/IP
• general requirements for the PC: see Hardware requirements
• the Dimmer Manager PC must be set to a fixed IP address
• that fixed IP address must be 2.x.y.z where x.y.z is to be selected by you
• subnet mask 255.0.0.0
• each NETPORT XT has a fixed IP address 2.a.b.c; it is printed on the back
• direct connection between the PC and a NETPORT XT, with a cross-link cable, usually works

Note: other equipment using class A IP addresses (2.a.b.c) includes Art-Net products in general;
lighting consoles such as ADB PHOENIX and MENTOR; ArtDMX-to-DMX converters such
ADB NETPORT; visualisers …
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Changing the User Level when OnLine

When in on-line mode, an increase in User Level requires a user name and a password.
Example: to select User Level 3

• set Working Mode to OnLine

This opens a dialogue window “Connect…”

• type the user name: UserLevel3 (this is cAsE-sEnSiTiVe)

• click OK (no password is required)

Automatic discovery

The following simple steps will create an automatic *.dim file with an overview of the whole dimmer
system.

• set the Network Address in the dimmer units (see Setting the Network Address of the dimmer
units)

• check the correct operation of the ADN network (see Use the “Master of…” function in the
dimmers)

• insert the NETPORT XT in the ADN daisy-chain (ADN network)

• connect the NETPORT XT and the Dimmer Manager PC (via a hub/switch, or directly)

• power up dimmers, NETPORT XT, hub… (see Powering-up sequence)

• in the folder "Dimmer Manager": if there is a file default.dim, delete or rename it (e.g.
OldDefault.dim)

• start the Dimmer Manager software (see Starting the Dimmer Manager software)

This opens a blank file.

• select OnLine mode and User Level 3 (see Changing the User Level when OnLine)

Now we start the automatic "discovery" procedure, which scans the Ethernet network and
generates a list of all the NETPORT XT (and NETPORT) found, with their dimmer units.

• or Menu Bar > Dimmers > Scan dimmers or click the "Scan the network" icon

This is followed by an upload of dimmer data; this may take a minute or so for a large dimmer
system.

The programme has created a group for each NETPORT XT; each group contains the dimmer
units connected to the NETPORT XT.

• check in the left hand column that all dimmer units are shown

• choose a filename and do a "Save As"

You have now created a *.dim file with the settings of the dimmer system. We suggest that you
use this method to create a back-up file of your dimmer configuration.

Note: Data are exchanged in two steps

•   preliminary data exchange with the (one or several) NETPORT XT small pop-up window:
     Waiting...-Waiting for NETPORT XT answers

•    data exchange with the dimmer units large pop-up window: Synchronisation- get data from
     dimmers
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Get FROM dimmers and Send TO dimmers

With Dimmer Manager, you actually have two data bases: the data base in the Dimmer Manager
PC, and the data bases in the dimmer units. During off-line periods, both data bases can evolve
independently.

So when you go OnLine and re-establish a connection between the Dimmer Manager PC and the
dimmers, you must decide which settings are "correct".

Get FROM dimmers: the Dimmer Manager PC will download the current settings from the
dimmers, and integrate the new data in the active *.dim file. The PC will thus for example be
updated about local changes performed on the dimmers while they were off-line.

Send TO dimmers: the Dimmer Manager PC will upload the current settings from the active *.dim
file to the dimmers.

WARNING Once you have sent data to dimmers, you can’t Undo that. But you can Upload an
older back-up *.dim file with the original dimmer settings.

WARNING Think "back-up"! Use the PC’s ability to store many *.dim files.

Local changes on the dimmers

When someone changes settings on the dimmer unit itself, you’ll see the following pop-up
warning message "Dimmer Local Change". The message includes "the name of the dimmer unit".

You must decide which settings are "correct". See Get FROM dimmers and Send TO dimmers.

Updating after you changed / added / removed NETPORTs, dimmers…

Any dimmer system is likely to evolve. NETPORT XT’s may be added or replaced. Dimmers may
be added or removed.

The following tools will allow you to update the information stored in the Dimmer Manager PC.

Removing a NETPORT XT

• Menu Bar > NetPorts > NetPort XT Manager
• click on the row number to select the NETPORT XT (selected = blue)
• click Delete
• in the pop-up window: click Confirm
• click Exit
You also have to delete it from the global list (tree).
• delect the line or icon representing the NETPORT XT
• delete and confirm
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Adding a NETPORT XT

• Menu Bar > NetPorts > NETPORT XT Manager
• click Scan

This opens a new window Netport XT Scan. On the right you see all the NETPORT XT found on
the network. This may include units belonging to other stages or studios in the same complex.
• on the right, select the NETPORT XT you want to add (selected = blue)
• click Use

This will move the NETPORT XT to the left hand column.
• click Exit to close

Replacing a NETPORT XT by a new NETPORT XT

You may wish to replace a NETPORT XT in an existing ADN system. The following procedure
explains an easy method.
•    Menu Bar > Netports > NETPORT XT Manager
•    click Scan

This opens a new window Netport XT Scan. On the right you will see all the NETPORT XT found
on the network. This may include units belonging to other stages or studios in the same complex.
• on the right, select the NETPORT XT you want to use (selected= blue)
• click Replace
This will move the NETPORT XT to the left hand column
• click Exit to close

Note: the name of the group icon representing the NETPORT XT is not affected by this swap.
Please check the old IP address is not mentioned in the group name.

Adding a dimmer unit

This function is useful for example when you add temporary dimmer units to a permanent system,
e.g. portable dimmers for decentralised use. Once they’re included, Dimmer Manager will check
for their presence - and can show them as absent.

When you Save, this particular *.dim file will store all the ‘Used’ dimmer units, including the
temporary ones.

When additional dimmer units have been connected to a NETPORT XT, you must update the file.
• check that all dimmer units are connected to the ADN Network, and powered up
• select On Line mode and User Level 3
• Menu Bar > NetPorts > NETPORT XT Manager
• click on the row number to select the NETPORT XT to which the dimmer units were added

(selected = blue)
• click Edit

This opens a new window "NETPORT XT"
• click scan network

This starts an automatic scan of the ADN ports of that NETPORT XT. The right-hand window lists
present units + units found earlier. New units are shown with their Network Adress but not yet with
a model name.

• select all the new dimmer units you want to monitor (selected=blue)
• for multiple selections:

• depress the CTRL key and keep it depressed
• select by a single-clicking on dimmer units

• click Use Dimmer

This is followed by a download (dimmer to PC) of the parameters. The model name appears.
• click Exit to close the window "Netport XT"
• click Exit to close the window "Netport XT Manager"
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Note: this Scan Network function will add newly found dimmer units to the system description
file, but it will not automatically remove absent dimmer units.

Deleting a dimmer unit - automatically

When dimmer units are missing (not responding), their icons will show up crossed in red. In some
circumstances it can be useful to ignore some of these dimmer units. Maybe a few of your mobile
dimmers are about to leave, and you then don’t want them to show up as "Missing". Or maybe
you won’t use all your dimmers for your next show.

You can automatically delete absent units from the list stored in the *.dim file.
• check that all necessary dimmer units are connected to the ADN Network, and powered up
• Menu Bar > NetPorts > NETPORT XT Manager
• select the NETPORT XT to which the dimmer units were connected (selected = blue)
• click Edit

This opens a new window Netport XT.
• tick Remove Absent Units
• click Scan dimmers

This starts an automatic scan of the ADN ports of that NETPORT XT. Only units found will be listed.
See above. When you Save, the *.dim file will only store the "Found and Used" dimmer units.
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Chapter 6: the Test and Flash functions

This chapter will describe three Test functions which allow you to remotely test dimmers, without
DMX or access to the lighting console. These functions require the OnLine mode.

For more details about these functions, we refer to the dimmer manual "Programming Digital
Dimmers and NETBUS".

Getting to the Test and Flash functions

• select the dimmer units (or Groups) you want to Test
• Menu Bar > Dimmers > Command > Test Dimmer or Flash Dimmer or Test Channel

Dimmer Test

Dimmer Test takes control of one dimmer in a unit, and overrides other controls such as DMX,
analogue and local memories.

The Dimmer Test dialogue window shows

• in the tab: the name of the dimmer unit example: MemoPack 15 @ 03

• the test level example: 50%

• the physical position in the selected dimmer unit example: 3

• the Dimmer Name example: Cyc2a

• the current DMX address example: 22

• the step (delay) time for the automatic Test Chaser example: 10 s

Note: Test takes into account the Dimmer Law for each dimmer.

Note: by selecting multiple dimmer units, you can simultaneously Test one dimmer in each unit.
To Test a group of dimmers without a lighting control desk, e.g. for focusing, you can use
the Edit Memory and Play Memory functions.
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Test and automatic Test Chaser

• to start the Test: click Test
• to start a Test chaser in the dimmer unit: click Automatic
• to stop the Test or Chaser: click Stop
• to stop the Test or Chaser and close the window: click Exit

Shortcut to Change Patch

In the event that the Test points out a DMX addressing error, you have direct access to the DMX
Patch via the Change Patch function.

Dimmer Flash

Dimmer Flash takes control of one dimmer in a unit, and overrides other controls such as DMX,
analogue and local memories. It is very useful to identify a dimmer in a rig without fading out the
whole rig.

The Dimmer Flash dialogue window shows

• in the tab: the name of the dimmer unit example: MemoPack 15 @ 03

• the Flash test level example: 50%

• the physical position in the selected dimmer unit example: 5

• the Dimmer Name example: Cyc3a

• the current DMX address example: 23

• the step (delay) time for the automatic Flash test Chaser example: 10 s

Flash and automatic Flash Chaser

• to start the Flashing test: click Flash
• to start a Flashing chaser in the dimmer unit: click Automatic
• to stop the Flashing test or Chaser: click Stop
• to stop the Flashing test or Chaser and close the window: click Exit

Shortcut to Change Patch

In the event that the Flash test points out a DMX addressing error, you have direct access to the
DMX Patch via the Change Patch function.
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• this will provide additional details about the dimmer unit it belongs to
example: dimmer Cyc2b is dimmer No. 4 in a 6 x 3kW MP15 with Network Address 3

• to start the test: click Test
• to end the test: click Stop
• to end the test and close the window: click OK

Other example: all "reds" on a cyclorama could be controlled by one channel number (or dimmer
name), with all those dimmers set to the same DMX address. They will still appear as individual
dimmers in the pull-down list.

Test a Channel (use of Dimmer Name)

This function allows you to use the Dimmer Name to find and then test a dimmer. You don’t need
to know the dimmer unit the dimmer belongs to.

The Dimmer Name can be the Channel Number, or an alpha-numerical text.
• or Menu Bar > Dimmers > Commands > Test a Channel

or position cursor on background, and right-mouse click then Test a Channel
• enter the Dimmer Name (channel number or text, see example below)
• click Enter
• select the Test level if necessary (default is 50%)
• to start: click Test
• to stop: click Stop

Dimmers having similar names

It may be that the same Dimmer Name (or Channel Number) is used for several dimmers. Then
a list with those dimmers will be shown.

Example
• in the field Name: enter the letter C
• press Enter
• this generates a list of all dimmers starting with C
• open the list
• select your target dimmer and press Enter
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Note: If the dimmer names for the Upstage dimmers are US150, US151, and so on, then by
entering Test a Channel: US you will get the list of all Upstage dimmers.

Note The Name selection field is case-sensitive. If you enter S you’ll get a list with SR, Sr, SL,...
If you enter SR you will see all dimmer names starting with SR, but you won’t see the dimmer
names starting with Sr.

Alternative automatic Test Chaser

As an alternative to Test a dimmer (automatic mode), you can use the Scan Loads function.
However, Automatic Test and Scan Loads are not exactly equivalent.

The differences are:
• in Test a dimmer you take control of only one dimmer; the others are not affected
• in Scan Loads all dimmers in the unit are Off, except the single Dimmer Under Test
• in Scan Loads you can’t choose the delay time
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Chapter 7: Learn Show, Learn – Scan – View Loads

This chapter describes the functions related to the Diagnostics of individual dimmers. It is
applicable to all EURODIM 3 cabinets, and to MEMOPACK, MEMORACK and EURORACK 60
which are fitted with the optional Extended Diagnostics (current measurement).

Learn Show

The role of Learn Show is to identify the dimmers that are used in a show, so that the Loads tests
and reporting can be limited to the dimmers that you actually use. This avoids long lists of status
messages about dimmers which are irrelevant for the show. The information "used /not used" is
one of the many parameters stored in the *.dim file for the show.

Learn Show – manual mode

Learn Show is performed manually or automatically. For the manual identification of Used
dimmers:
• select the dimmer units required in the show

E.g. by selecting some Groups, or by selecting the NETPORT XT
• Menu Bar > Dimmers > Command > Test Channel
This opens a dialogue window “Learn Show”

• select the tab of a dimmer unit
• to select: tick in the column Used; to un-select: tick again

Learn Show - shortcuts for manual selection
• "Reset" will un-select all dimmers
• "Sel. All" selects all dimmers
• "For this dimmer only" to Reset / Select / Grab only the dimmers on the selected tab
• "All selected dimmer units" to Reset / Select / Grab in all selected dimmer units
A quick way to select "all dimmer units" is to select all the NETPORT XT's.
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Learn Show – automatic mode using DMX (grab)

Learn Show is performed manually or automatically. In automatic mode, Used Dimmers are
identified by monitoring their DMX level. If the DMX level reaches a value above the threshold level,
the dimmer is "Used". This information is memorized.

One of the possible approaches on the lighting control desk is:
• build a cue which includes all the dimmers used in the show
• then set these dimmers at a DMX level of e.g. 10% (above the Trigger Level)

Step 1: start the automatic Learn Show mode

In Dimmer Manager:

• select the dimmer units required in the show
E.g. by selecting some Groups, or by selecting the NETPORT XT

• Menu Bar > Dimmers > Command > Learn Show

This opens a dialogue window “Learn Show”

• to start the automatic detection: click Grab

Grab for All Selected Dimmer Units: one click will transmit the order to all selected units

Grab for This Unit Only: if you want to view the changes while they happen

• Menu Bar > File > Save to save this information in the current *.dim file

Step 2 : the lighting control desk tells us which individual dimmers are used in the show

There are different ways to use this automatic mode; three methods are:

Method No. 1

On the lighting control desk:
• build a cue which includes all the dimmers used in the show
• then set all these dimmers at a DMX level of e.g. 10% (above the Trigger Level)

Method No. 2

On the lighting control desk:
• go through the cues one by one
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Adjusting the threshold level

The default value for the threshold (trigger) level is 5%.
To adjust this threshold:
• select the dimmer units
• Menu Bar > Command > Learn Show
• set the trigger (threshold) level

Note: the threshold level is in the area ‘All selected dimmer units’ and the new threshold is
applied to all selected dimmer units in a single operation.

Note:  if the console applies ‘preheat’ to some dimmers, and this preheat level is higher than the
trigger level, then these dimmers will be tagged “Used: Yes”.

Learn Loads

Learn Loads tests the dimmers, measures the connected load, and memorizes that load as a
reference for future comparison. Learn Loads must only be performed on a lighting rig known to
be OK.

• select the dimmer units
• Menu Bar > Dimmers > Command > Learn Loads

Method No. 3

Activate GRAB at the start of the rehearsal.

Step 3 : stop the learning process

Stop the GRAB learning process by clicking on STOP.
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This opens a dialogue window "Learn Loads"

To perform a Learn Loads to the dimmers which are used in the show
• click Show Selection (this will highlight the Used dimmers)
• click Learn

To perform a Learn Load for all the dimmers in the selected units
• click Learn

You can follow the progress of the process.
• click Exit to close the window

Note: when you apply Learn Loads to several dimmer units, the tests will run simultaneously in
all the selected units. Learning a complete system takes about as long as learning its
largest dimmer unit.

Note: Learn Loads affects the lights on stage. When you apply Learn Loads to a dimmer unit,
this will set all its dimmers to Off, and will fade up each dimmer in turn. Partial testing of
the system, without affecting the other dimmers, is easy because you can select the
dimmer units to be Learned.

Note: if a dimmer has been set to the NonDim law in the dimmer unit, then that dimmer will be
skipped by Learn Loads and the Learn value will show “NonDim”. This is to protect the
load: the Learn Loads process fades up the dimmer level, and setting a local NonDim law
implies that you don’t want that load to be dimmed.

Scan Loads

Scan Loads tests the dimmers, measures the connected load, and compares it with the Learned value.
• select the dimmer units
• Menu Bar > Dimmers > Command > Scan Loads

This opens a dialogue window "Scan Loads".

To perform a Scan Loads only on the dimmers which are used in the show
• click Show Selection (this will highlight the Used dimmers)
• click Scan

To perform a Scan Loads for all the dimmers in the selected dimmer units
• click Scan

You can follow the progress of the process.
• click Exit to close the window
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If you close the window before the Scan/Learn is finished, Dimmer Manager will ask you whether
you want to interrupt, or continue in the background.

Note: when you apply Scan Loads to several dimmer units, the tests will run simultaneously in
all the selected units. Testing a complete system takes about as long as testing its largest
dimmer unit.

Note: Scan Loads affects the lights on stage. When you apply Scan Loads to a dimmer unit, this
will set all its dimmers to Off, and will fade up each dimmer in turn. Partial testing of the
system, without affecting the other dimmers, is easy because you can select the dimmer
units to be Scanned.

Note: if a dimmer has been set to the NonDim law in the dimmer unit, then that dimmer will be
skipped by Scan Loads and the Scan value will show "NonDim". This is protecting the
load: the Scan Loads process fades up the dimmer level, and setting a local NonDim law
implies that you don’t want that load to be dimmed.

Learn Loads or Scan Loads of one dimmer

You may want to perform a re-Learn or re-Scan of one dimmer, without repeating the process
for the other dimmers.
• select the dimmer unit(s)
• Menu Bar > Dimmers > Command > Learn Loads
This opens the dialogue window "Learn Loads"
• select the dimmer you want to Learn (or Scan)

(to select more than one dimmer: keep CTRL depressed while selecting)
• click Learn (or Scan)

View Loads

View Loads does not test any dimmer. It shows the Learned values, the results of the latest Scan
Loads, and the comparison.
• Menu Bar > Dimmers > Command > View Loads

This opens a dialogue window “View Loads”.

Clear Loads

Clear Loads erases the reference values (Learned Loads) and the latest results (Scan Loads).
• select the dimmer units to be Cleared
• Menu Bar > Dimmers > Command > Clear > Clear Loads
• opens a pop-up window "Are you sure ?" to confirm: click Yes; to cancel: No
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How to manually set Learn Values ?

Example: for CPU1 in a EURODIM 3
You set Dimmer Manager Off-line
Select the correct CPU.
Right-click > Command > Learn Loads
You get a pop-up window LearnLoads (see screenshot).

For every dimmer channel there is a pull-down selection.
One of the possible values is 600 W.

Copying it to the other CPU - method 1
In Dimmer Manager Off-Line you make a copy of the CPU.
In the copy-of-CPU1 you change the ADN address.
You then do a SendToDimmers to CPU1 and CPU2.

Copying it to the other CPU - method 2
You do a Send To Dimmers to CPU1.
In the dimmer room on CPU2 you do a ‘Get Data Base’
On Dimmer Manager you do a ‘Get From Dimmer’ so that the PC is up to date.

Pin-out of XLR5

XLR5-M
(6117.15.110)
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Chapter 8: status and error reporting

The four coloured flags in the icons

The dimmer units detect events such as Loss of DMX, Fan Failure, Missing phase,… These events
are already displayed on the dimmer unit’s local display. Thanks to ADN, they’re also reported
back to the Dimmer Manager PC.

Overview of all the error messages – direct access

In OnLine mode, a System Summary is shown permanently in the lower left hand corner of the
screen. To view the source of Warning or Error: double click on one of the four flags.

This opens a new window “Errors Board”.

• each line represents a dimmer unit; only dimmer units reporting a Warning or an Error are listed
• the columns represent all types of events
• the colour coding is defined in the Error filter of the dimmer unit.

We will now cover in detail the interpretation of the colours, and the use of coloured flags in the
icons.

The three colours

The colour codes are
• Red = Error
• Orange = Warning
• Green = OK or Ignore

You are free to decide for each event which flag colour it gets. This choice is stored in the *.dim
file because the importance of an event usually varies with the show.

The coloured flags

When you are OnLine, the icons of dimmer units and groups will show four coloured flags. Each
flag represents a family of status or error messages. The colour of the flag - green, orange, red
- is user-defined depending on the importance of the event for this show. See How to edit the Error
Filter for a dimmer unit and The Global (Default) Error Filter.
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The four families of events

From top to bottom, the four flags represent the following families:
• Voltage: "400 V overvoltage" and "No L…" (missing phase or low voltage)

• Temperature: Overtemperature warning and gradual fade-out

• DMX: "No DMX 1", "No DMX 2", "DMX errors"

• Miscellaneous: "Fan Failure" (and a few others)

The Global (Default) Error Filter

The Default Error Filter defines how to display status messages in the Dimmer Manager PC. It
does not affect the messages displayed on the Dimmer Units themselves.

The Global Error Filter, and individual changes with Edit Error Filter, are all stored in the *.dim file.
So one type of error can get a Red flag in one show, and a Yellow or Green flag in another show.

Example: if you only use the DMX B input for Guest desks, then you can set "DMX B Missing"
to Yellow (Warning) or Green (Ignore) when no Guest desk is present.

Working OnLine: the Default Error Filter is applied to all dimmer units; exceptions: the units
changed by means of Edit Error Filter.

Working OffLine: the Default Error Filter is automatically applied whenever a new virtual dimmer
unit is created.

The "Global Error Filter" window also shows the settings of individual dimmer units (see
illustration).
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How to edit the Global (Default) Error Filter

• select User Level 3 or higher
• Menu bar: Parameters > Global error filter

Note: as a precautionary measure, events such as 400 V overvoltage, over-temperature,…
cannot be set to "Ignore" (green flag) in the Default Error Filter. Should you wish to set them
to Ignore, then you must edit the Error Filter for the individual dimmer units.

Ignore local changes on the dimmer units

When someone uses the local menus on the dimmer unit, Dimmer Manager automatically shows
a pop-up message. The data base in the PC is now probably different from the data base in that
dimmer unit, so you must synchronise them. Click  "Get from dimmers" or "Send to dimmers".

If, in Global Error Filter, "Ignore DB (data base) change" is ticked On, then this pop-up window
is disabled. This can be useful when several people are working on the same dimmer system.

It is preferred to set "Ignore" back to Off after your dimmer system set up is completed.
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How to edit the Error Filter for a dimmer unit

• select the dimmer unit

• Menu bar: Dimmers > Edit > Error filter

This opens a window "Edit dimmer’s error filter"

• remove the check for "Use default filter"

• edit the Error Filter

• click Apply to confirm and OK to close the window

• Menu bar: File > Save to save your settings in the current *.dim file
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A coloured flag in a group icon – what does it mean

A yellow flag for a dimmer unit means that one event (or several) of the category "Warning"
happened for that unit.

A yellow flag for a group means that one group member reports that type of event.

Example: you have a group representing a dimmer room. If the upper flag (Voltage) is yellow
(Warning), then you know that one of the units in that room reports an event belonging in the family
"Voltage".

If several dimmer units report an error in the same category, then their group icon will show the
most severe colour.

Example: for all the dimmer units connected to this NETPORT XT
• none of the units has a "Red = Error" event in the family "Voltage"
• none of the units has an event in the family "Temperature"
• none of the units has an event in the family "DMX"
• one or several units have an event in the family "Miscellaneous"
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Chapter 9: Customised Global Overview lists

A large dimmer system stores many hundreds of parameters, and it would be quite unpractical
to show them all in a single picture. Depending on the task at hand, you will be looking for a
personalised overview of a just few parameters. Dimmer Manager includes a function which does
just that: create custom lists of parameters, with sort functions.

Dimmer Manager includes several standard overview functions, plus a tool to create, store, and
recall "my favourite custom overviews".

Some all-purpose standard Overviews (queries) are already included.

How can I get an Overview of patch, factors and dimmer laws ?

• Patch_Law_Factor_Smoothing.ovc lists Dimmer Names, Patch A, Patch B, Dimmer Law,
Factor, Smoothing per dimmer, plus general information such as Unit Name, Network
Address

How can I get an Overview of patch and House Patch ?

• Patch_and_HousePatch.ovc lists Patch and HousePatches, plus general information such
as Unit Name, Network Address

• expand, to show the information at individual dimmer level

How can I get an Overview of the contents of the local memories ?

• Memories_levels.ovc lists the levels for all the memories

How can I get an Overview of "What happens when DMX fails" ?

• If_DMX_fails.ovc lists the settings for "If DMX fails", plus general information such as Unit
Name, Network Address.

How can I see whether multiple dimmers are set to the same DMX address ?

• use the query Patch_and_HousePatch.ovc
• expand, to show the information at individual dimmer level
• click on the DMX column, to sort per DMX
• browse the DMX column

How do I perform a query ?

Example: you want to use the standard query Patch_Law_Factor_Smoothing.ovc

Step 1 : select the information you want to see

• select the dimmer units (or groups) you want to include in the overview
• Menu Bar > Parameters > Overview > Configuration
• click Load Topics
• this opens a window "Load an overview configuration"
• in folder Dimmer Manager, select your query Patch_Law_Factor_Smoothing.ovc

and Click Open
• in the window Global Overview Configuration: click OK

You now have defined what will be shown.
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Step 2 : view the result of your query:

• Menu Bar > Parameters > Overview > Show

You now see the columns as defined in Patch_Law_Factor_Smoothing.ovc

You can expand the overview, to show detailed information and one line per dimmer.

To expand: click on the name of the Dimmer Unit.

You can collapse the overview, to show just one line per dimmer unit.

If you wish to expand several dimmer units, we suggest that you first expand the last dimmer unit
on the list.

To collapse: click on any Dimmer line of the dimmer unit.

Collapsing will also hide the columns related to dimmer details.

Sorting of the results

The results are sorted in alphabetical order. You can sort per "Name" , per "DMX address",... Click
on the title of the column to sort. Click again for reverse sorting.

Example: the result of query Patch_Law_Factor_Smoothing.ovc can be sorted per dimmer Unit
Name, per Dimmer Name, per DMXA address, per DMXB address, per dimmer law, ...
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How do I create a new Custom Query ?

The pre-programmed queries include Patch_Law_Factor_Smoothing, If_DMX_fails,
Memories_Levels…

Example: to get a list showing Dimmer Units, their names, and the names of the individual
dimmers.
• Menu Bar > Parameters > Overview > Configuration
• this opens a window titled Global Overview Configuration

• tick the boxes: Dimmer Unit, Dimmer Unit Name, Network Address, Dimmer Name,...
• click the Save Topics button
• give it a name: List_of_Names.ovc

All *.ovc files are stored in the folder "Dimmer Manager"



Dimmer Manager software

Instruction Manual - page 38
Issue: 004 Lighting Technologies

Chapter 10 : Creating a virtual dimmer system (off-line)

This chapter will explain how you can create a *.dim file while off-line, with virtual NETPORT XT
and virtual dimmers. This is possible without physical connection to ADB dimmers.

Preliminary notes

Preparing off-line means you’ll have to anticipate
• the Network Address for each dimmer unit
• the IP address for each NETPORT XT

If you prepare off-line, and you are unsure about the IP addresses of the NETPORT XT, then we
recommend that you set addresses 3.x.y.z for all virtual NETPORT XT. The correct IP addresses
can be edited later. The 3.x.y.z won’t conflict with real the IP addresses of the units, and the value
3 will make it easy for you to spot that it’s not the real IP address.

If you are unsure about the Network Address of a dimmer unit, then we recommend that you set
Network Address = 0. The correct Network Address can be edited later (see Edit Global Dimmer
Parameters).

Before creating new dimmer units, you may wish to read the paragraph about the Default Error
Filter.

Creating a virtual NETPORT XT

Creating a group requires User Level 3 or 4.
• Menu Bar > NetPorts > NetPort XT Manager

This opens a window NetPort XT Manager
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• enter the IP address (see Preliminary notes)
• enter a user-defined name (recommended, not required)
• click Exit to close the window "NetPort XT"
• click Exit to close the window "NetPort XT Manager"

If your dimmer installation uses more than one NETPORT XT you’ll have to repeat the steps. All
NETPORT XT will be listed in the window "NetPort XT".

We now suggest to create a virtual group for every NETPORT XT. (The automatic discovery
procedure does this too).

Creating a virtual group

Dimmers are usually organised in groups. A group can be a dimmer room, a touring rack, all
portables, the two CPU‘s of a EURODIM 3, all the dimmer units connected to a NETPORT XT…
It is good practice to first create those groups, and then create the virtual dimmers in their group.

Creating a group requires User Level 3 or 4.
• open the target window
• place the cursor over the target window and single-click
• Menu bar > Dimmers > New group

This creates a new group in the target window.
To rename the group
• select the group
• right-click and select Rename
• type the new name

Click New; this opens a window "NetPort XT"
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Creating a virtual dimmer unit

Creating a dimmer unit requires User Level 4.
• open the window of the group to which the unit will belong
• click on the window
• Menu bar: Dimmers > New Dimmer

Complete the following fields:
• Name : user-defined name for the dimmer unit
• NETPORT XT : select from the pull-down list
• Model : select from the pull-down list
• Configuration : select from the pull-down list
• DMX Lines : number of DMX inputs

most units : 1
EURODIM 3 : 2 (standard)
EURORACK 60 : 1 (standard); 2 (option “Dual DMX input kit”)

• Network Address : the range is 1-99; set Network Address to 0 if you
don’t yet know

• Network Address for EURODIM 3 : tick whether single or dual CPU
ED3 with dual control electronics requires two Network
Addresses
CPU1 = left; CPU2 = right.

• click OK to close.

Note: In a later phase you’ll also have to set a few additional parameters for the dimmer unit.
See Chapter 3: the Edit Parameters functions.
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Creating a virtual dimmer system

Creating a dimmer system requires User Level 4.

Step 1: open a blank file and choose a filename

• Menu Bar: File > Open > New
• do a Save As: Menu Bar > File > Save As

Step 2 :any system requires minimum one NETPORT XT; to create:

• Menu Bar: NETPORT XT > NETPORT XT Manager

• click New

This opens a window NETPORT XT.
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Step 4: for each unit, Edit the dimmer parameters

• select the icon of the dimmer unit
• or: Menu bar: Dimmers > Edit > Dimmer parameters or: right-click: Edit > Dimmer

parameters

• edit the IP address of the NETPORT XT

• enter a name for the NETPORT XT

• click Exit

Step 3: create the dimmer units; see Creating a virtual dimmer for more details.

For each unit, type the name, the Network Address, and the NETPORT XT it’s connected to.
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You can now edit the start address, set what happens when DMX fails,…

Step 5: select/drag the dimmer units into the groups. See relevant paragraph.

Step 6: it is now time to do a Save

• Menu bar: File > Save

Note: working files can be saved in the folder Dimmer Manager. Back-up files should be saved
elsewhere.

Note about EURODIM 3
The PC can Get (download) the configuration of a physical EURODIM 3 dimmer cabinet.
The configuration gives the distribution of 3kW, 5kW, 10kW modules over the cabinet. You
cannot edit the configuration of a virtual ED3 cabinet.

Making virtual clones

If you need several similar dimmer units, you can make virtual clones. The default text parameters
of the clone (the unit’s name, the text in the memo) will refer to the original “Copy of…”.
• select the father unit
• or: Menu bar: File > Edit > Copy or: right-click > Copy
• select the target window
• or: Menu bar: File > Edit > Paste or: right-click: Paste
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Chapter 11: FAQ – frequently asked questions
How do I change the configuration which appears at start-up

When Dimmer Manager starts, it automatically opens the file default.dim. If no default.dim is found
in the folder Dimmer Manager, then a blank file is created.

When you first install Dimmer Manager, default.dim will be the copy of a sample file. You can easily
personalise this.

Example: you want Dimmer Manager to automatically start with MyDefaultRig.dim.

In folder Programs > folder Dimmer Manager
• rename or delete the file default.dim
• make a copy of MyDefaultRig.dim
• rename the copy; new name: default.dim

Using CTRL and SHIFT to select multiple dimmer units

• keep the CTRL key depressed
• select by single-clicking on dimmer units
Fast select of a range of dimmer units
• keep the SHIFT key depressed
• click on the first dimmer unit, click on the last dimmer unit

Using CTRL to unselect dimmer units

You have selected some dimmer units. You want to un-select one dimmer unit
• keep the CTRL key depressed
• un-select by single-clicking on the dimmer unit
Canceling the complete selection
• release SHIFT or CTRL
• single-click in the window, next to a dimmer unit

What does the shaded grey cross mean ?

The grey cross only appears in OnLine mode and for EURODIM 3 cabinets fitted with the optional
dual (instant back-up) electronics. A non-active CPU is shown with a shaded grey cross: it is OK,
but is does not have control over the dimmers.

What does the red cross mean ?

The red cross only appears in OnLine mode.

A red cross over a ‘dimmer unit’ icon indicates that it is not responding. See Troubleshooting.

A red cross over a ‘group’ icon indicates that none of its dimmer units is responding.

A red cross over a NETPORT XT icon indicates a problem with either the NETPORT XT, or with
the connection to its dimmer units, or with all its dimmer units. To check the status of the
NETPORT XT itself: see NETPORT XT Manager, and/or Troubleshooting.

System-wide Play Memory control panel - how can I put names in the buttons ?

Application: some general purpose-cues are stored in the dimmers, and you want to put a custom
text in those ‘buttons’.

Solution: you can make your ‘local language’, in which you change the standard texts (PANIC,
Memory 1, …) by custom texts. Please refer to Linguist. You’ll find the standard texts in Context:
PlayMemoryKeyboard.



Dimmer Manager software

Instruction Manual - page 45
Issue: 004Lighting Technologies

Glossary

ADN Advanced Dimmer Network; name for the network which establishes
serial bi-directional communication between dimmer units, and
between NETPORT XT and dimmer units. The name is also used for
the proprietary protocol. ADN is based on EIA-485 and meets the
DMX512/1990 standard. ADN uses the second data pair in the
DMX cable, or a dedicated data cable. ADN is half-duplex (bi-
directional communication over one data pair).

Back-up look see (local) memories

Cue see (local) memories

Curve see dimmer law

Custom law user-defined dimmer law, which is stored in the dimmer unit. The
Dimmer Manager PC stores a library of standard and custom laws.

Dim file file generated by Dimmer Manager; includes equipment (dimmer
units, NETPORT XT); all dimmer settings (patch, laws, local
memories); system organisation (groups, names); alarm settings,…

Dimmer one of the dimmer channels in a ‘dimmer unit’; a MEMOPACK 30
- 12 x 3 kW is a dimmer unit with 12 dimmers

Dimmer curve see dimmer law

Dimmer law the relation between the control level (DMX) and dimmer output
voltage

Dimmer manager a software programme; filename dimmer.exe

Dimmer manager PC the PC which runs the Dimmer Manager programme

Dimmer module a EURODIM module; can hold one or two dimmers

Dimmer name user-defined alpha-numerical text attached to a dimmer; can be
different for every show

Dimmer unit a EURORACK 60, a EURODIM 3, a MEMOPACK 30,...

DMX512-A the future release of the DMX standard; successor to
DMX512/1990

FTP cable foiled twisted pair; a type of Ethernet cable which is also suitable for
the distribution of DMX and ADN signals

House patch preferred DMX patch; stored in the dimmer unit

law file file describing a dimmer law

Linguist a programme for the translation of Dimmer Manager to additional
languages

Local Control when you use the local keys / display / menu of the dimmer unit

NETBUS a portable remote dimmer control unit, which communicates with
ADB digital dimmers over the ADN network
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NETPORT a converter unit which transforms Art-DMX data (DMX-over-Ethernet)
to two independent DMX512 universes (outputs)

NETPORT XT a converter unit between the ADN network and the Ethernet
network; also includes the NETPORT functions (two independent
DMX outputs)

Network address the identification number of a dimmer unit or NETBUS on the ADN
network

OVC file a file describing which parameters will be shown in a query

Priority cue a.k.a. cue number 0. A special cue: always has priority over DMX;
is not included in the Memory Chaser.

RDM Remote Device Management. Name of the future ESTA standard
and protocol for serial bi-directional communication with dimmer
units, moving lights,… It’s A Major Work In Progress. At the day of
writing this manual we don’t know when RDM will be released; and
it is uncertain whether RDM will use the first data pair (bi-directional
RDM data intermixed with uni-directional DMX data) or the second
data pair (which gives much better response times). See Important
information.

Right-click a click on the right-hand mouse button

STP cable shielded twisted pair; a type of Ethernet cable which is also suitable
for the distribution of DMX and ADN signals

System-wide the system-wide commands Play and Record are broadcast to all
dimmer units on the ADN network, to achieve synchronous
response.

Terminator or termination resistance. Resistance wired across a data pair
R = 120 ohm for DMX and ADN. See Appendix x: data line
termination.

Unit usually refers to a dimmer unit (a MEMOPACK, a EURODIM 3,…)

Universe from the standard: a DMX512 data link originating from a single
DMX source. Control of up to 512 DMX512 data slots comprises a
single universe.
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Appendix A: How to distribute DMX and DMX+ADN

ADN is a bi-directional protocol, and classic DMX amplifiers or splitters are not designed for bi-
directional operation. Furthermore, ADN uses the second data pair, which is discarded by
conventional DMX splitters.

This example shows a simple and economical method to distribute DMX and DMX+ADN
throughout a venue, using standard DMX boosters/splitters and one or several NETPORT XT.

In our example, a DMX lighting console generates the DMX signal. NETPORT XT is used for its
"ADN-to-Ethernet" function; its ArtDMX-to-DMX function is not used.

The DMX patch panel

The connection points are located throughout the venue or studio. Depending on the show, some
will be used for DMX+ADN, with the majority used for DMX only.

All these connection points are wired to a central XLR5 patch panel. The cabling can either be
classic DMX cabling (2 data pairs + screen; EIA-485), or Ethernet STP/FTP cabling fitted with
XLR5 connectors.

The DMX splitter

A DMX splitter is required to achieve a star-distribution of the DMX signal, and because you can’t
connect more than 32 standard receivers to one DMX output.

Outgoing lines with DMX

These lines are going to locations with DMX-only equipment: colour changers, automated lights,
strobes, smoke/fog generators, dimmers without ADN…

Outgoing lines with DMX+ADN

Such lines are far fewer in numbers. Each NETPORT XT features two independent outputs, so with
two NETPORT XT you can connect four DMX+ADN outgoing lines. E.g. one to the main dimmer
room, one backstage, and two for decentralised portable dimmers.

DMX generated by a conventional console (without ArtDMX)

In our example, the DMX signal is provided by a DMX console.

"Outgoing lines with DMX" are connected to an output port of the splitter.

"Outgoing lines with DMX+ADN" are plugged to a port of the NETPORT XT, which in turn is
connected to a splitter output port. These DMX data are not affected by the NETPORT XT. The
NETPORT XT adds ADN data to the second data pair.

DMX Console

                STUDIO or THEATRE

Conventional
DMX Splitter

                             8 x Amplified Output

XLR5 male

2 x NETPORT XT

DMX
DMX + ADN
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Appendix B: data line termination

This chapter will cover the rules about termination on the DMX and ADN networks.

Situation A: Independent ADN cables

This is the case where a dedicated cable is installed for ADN. Termination of the DMX network
is independent of the ADN system.

Example No. 1: the NETPORT XT is at one end of the ADN daisy-chain, in the control room or
in the dimmer room. Then you must terminate the ADN data pair at the other end of the ADN line.

Example No. 2: the NETPORT XT is inserted in the daisy-chain e.g. on stage. You must terminate
the ADN data pair at both ends.

Term.

Term.

Term.

Term.

Term.
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Example No. 4: the DMX console is in the control room, at one end of the daisy-chain.
NETPORT XT is inserted in the daisy-chain e.g. on stage. In the control room you must terminate
the second data pair (pin 4 and 5). And at the other end of the DMX+ADN line you must terminate
both data pairs.

Situation B: DMX+ADN cables – DMX generated by a console

This is the case where NETPORT XT is used exclusively for ADN and Dimmer Manager. Its "DMX
out" functionality is not used. The DMX data come from a console, at one end of the daisy-chain.
The cabling is two-pair DMX+ADN cable.

The two data pairs in the DMX+ADN cable need to be terminated. One termination resistor
comes between pin 2 and pin 3; one termination resistor comes between pin 4 and pin 5.

Example No. 3: the DMX console and the NETPORT XT are in the control room, at one end of
the daisy-chain. Then you must terminate both data pairs at the other end of the DMX+ADN line.

Note: the active DMX output of the lighting console (or a DMX amplifier/booster/splitter) replaces
the termination for the DMX pair at that end. But you still have to terminate the ADN pair at that
end. A very practical tool is a XLR5M-to-XLR5F with internal resistor (120 Ohm) between pins 4
and 5.

2 x Term.

2 x Term.

Term. (ADN)
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Example No. 6: the NETPORT XT is inserted in the daisy-chain e.g. on stage. You must terminate
both data pairs at both ends.

Situation C: DMX+ADN cables – DMX generated by the NETPORT XT

This is when both the DMX and the ADN functions of NETPORT XT are used.

Example No. 5: the NETPORT XT is at one end of the daisy-chain. Then you must terminate both
data pairs at the other end of the DMX+ADN line.

2 x Term. 2 x Term.

2 x Term.
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Appendix C: Preparing and testing an ADN network

This chapter will cover a few rules and tips for the lay-out of the ADN network. For detailed
information, please refer to the manuals for the NETPORT XT and for the dimmers.

Why does NETPORT XT also have XLR5-M connectors ?

The classic set-up of a DMX network has the DMX console at the start of the daisy-chain.
However, the electrical standard on which DMX and ADN are based (EIA-485) does not assume
it. (In most networks each device talks in turn, and talking is not a prerogative of the device at the
end of the line).
Conclusion: You can position a NETPORT XT at the start of a DMX+ADN daisy-chain, but you
don’t have to.

NETPORT XT can be inserted in a DMX+ADN daisy-chain at the most convenient place, e.g. at
a location close to an Ethernet connection. As Ethernet cables are limited to an absolute max. of
100 m cable length between nodes, this extra flexibility provided by NETPORT XT is an important
user benefit.

We all know from the DMX rules of good practice that with the transmitter (console, data booster)
at one end, you must terminate the line at the other end.

If the "transmitter" is not at the end of the daisy-chain, then you have two ends, which both must
be terminated. See "Appendix B: data line termination".

Setting the Network Address of the dimmer units

Every dimmer unit, and every NETBUS remote control unit, must have a proper "Network
Address". This address identifies the unit on the ADN network. This address must be set on the
dimmer unit itself; this is done in Menu Level 3. The default setting is Netw.Addr. - - - (zero). For
full details, see The Programming Digital dimmers and NETBUS.

The dimmer unit’s display shows the current Network Address Netw.Addr. xx, alternating with
the current DMX setting DMX start xxx or House Patch On or DMX Patch On. (If it does not
show then Netw.Addr. is set to - - - i.e. 0). The valid range for the Network Address is: 1 to 99.

Please check carefully that no two units connected to the same NETPORT XT have the same
Network Address.

If you are uncertain about the Network Address to use for a dimmer unit, then set it to 0 (zero).
It will thus not conflict with other units. It will be invisible for, and will not respond to, the ADN
network.

Symptoms when two identical addresses are used: see Appendix D: Troubleshooting an ADN
network.

How many dimmer units can I connect to one NETPORT XT

The limit is set by the EIA-485 standard. The following rules apply
• max. 32 dimmer units connected to port A
• max. 32 dimmer units connected to port B

Note: a Network Address used on port A cannot also be used on port B.

Note: a EURODIM 3 cabinet with dual (instant back-up) electronics counts as two units.

Note: above 32 + 32 units: by far the simplest solution is to add a NETPORT XT, which provides
a connection for again 32 + 32 dimmer units. See Appendix A: How to distribute DMX
and DMX + ADN.



Dimmer Manager software

Instruction Manual - page 52
Issue: 004 Lighting Technologies

With two NETPORT XT you can use the same Network Address twice

In some special circumstances it may be interesting or required to use the same Network Address
twice. Two dimmer units can have the same Network Address, provided they are connected to
a different NETPORT XT.

Check that the cable type is correct

As with DMX, some contractors may be tempted to use screened cable, which does not have
twisted pairs. This will result in crosstalk between ADN, DMX, ... etc. This will not be noticed with
simple "dc buzzer" tools. Use a proper DMX test tool which uses a data signal to test the line.

Check that data pairs stay together

As with DMX, there are cases where "twisted pair" cable was used, but pairs were "not kept
together":  Data + of pair 1 is - unfortunately - combined with data – of pair 2. And data - of pair
1 is combined with data + of pair 2.

WARNING! This will not be noticed with simple "dc buzzer" tools! Use a proper DMX test tool.

Check all the extension cables

Check all the extension cables, one by one. Use a proper DMX tester. Perform a "double ended
test" on both data pairs (pins 1, 2, 3, 4 and 5).

Non-ADB equipment: check the continuity of the second data pair

The next issue of the DMX512 standard is planned to include a section on the marking of DMX
equipment, to indicate whether the second data pair is linked through inside the unit.

Meanwhile: check!

Use of NETBUS and Dimmer Manager
The Advanced Dimmer Network accepts only one Master. This is either the Master NETBUS, or
the NETPORT XT. If both are simultaneously present on the ADN Network, you’ll get error
messages.
The following set-up has been used successfully

- NETBUS and NETPORT XT are both present in the ADN daisy-chain.
- An inverting switch in the control room applies 230 V to either NETBUS or NetPort XT,

so that only one of them is active at any time.
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Appendix D: Troubleshooting an ADN network

This chapter will give you a few tips for the troubleshooting of the ADN network, in preparation
of its connection to a NETPORT XT and the Dimmer Manager PC.

Your first check

Verify that the rules laid out in "Appendix C: Preparing and testing an ADN network" have been
respected.

Check for non-ADN signals

Any manufacturer can use the second data pair (pins 4 and 5 on the XLR5) within the electrical
limits set by the DMX standard. Equipment then won’t be damaged by the signals applied by
others; but the presence of non-ADN signals on the ADN network will of course stop communication.

DMX512-A, the next issue of the DMX512 standard, will probably include a section on the
marking of DMX equipment, to indicate its usage of the second data pair. Some tips:

• Check for the presence of a dc voltage between pins 4 and 5. There is a possibility that some
equipment (lighting consoles, colour scroller power supply units,...) applies dc voltage to the
second data pair. This will make any communication over the ADN network impossible.

• Check the data sheets. Check for any use of the second data pair by other equipment.

• Some console manufacturers and/or rental companies use the second data pair for a second
DMX universe.

• Some dimmer manufacturers may use it for basic feedback, e.g. a low dc voltage to indicate
temperature problems. In that case, your ADN will work fine until such an alarm pops up.

• Others may have a different protocol.

Use the "Master of…" function in the dimmers

We recommend that you fully test the ADN network before you insert the NETPORT XT. Such
testing is straightforward with the standard software functions in the dimmers; a NETPORT XT
or a PC is not required – in fact the NETPORT XT must be disconnected from the ADN network.

For installed cables, check ADN cabling by means of the local function "Master of..." in the
dimmers.

Principle: use one dimmer unit and make it "Master of..." one of the dimmer units in the ADN
network.

First repeat this for all the dimmer units in a dimmer room or touring rack. Then extend to more
units, until you are satisfied that one unit can communicate with all other dimmer units.

More about "Master of" in the User Manual "Programming Digital Dimmers and NETBUS".

What can I learn from the error messages ?

When in "Master of…" mode

WaitingSlave means that no response is received from the potential slave

ADN error could mean no response is received from the potential slave

ADN error could mean that two units want to become master of the same ADN network

ADN error could mean that non-ADN data (DMX?) is present on the ADN network.
See check for non-ADN signals

ADN error could mean that you mix old and new firmwares, see Older firmware and
"MODBUS error" or "ADN error" messages

DMX errors could mean that there is cross-talk between ADN and DMX; wrong cable type ?
crossed data pairs ? Find more in Appendix C: Preparing and testing an ADN
network
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Dimmer firmware requirements

The dimmers need to be fitted with firmware 3.00 or later. The EPROM file can be downloaded
from the ADB website. The firmware version is displayed during the power-up of the dimmer
unit.

Older dimmer firmware and "MODBUS error" or "ADN error" messages

Please first check the firmware version of your dimmer unit. It is displayed during the power-
up sequence of the dimmer.

The ADN part of the current firmware (version 3.00 and later) is not compatible with the ADN
part of earlier firmware versions. Mixing old and new units on the same ADN network causes
a "MODBUS error" or "ADN error" message.

Solution: we recommend that you upgrade the firmware in the dimmers. You will thus benefit
of all the improvements in the general functions. The EPROM file is downloadable from the
ADB website.

A workaround is to temporarily only include recent dimmers in the ADN link.

For "ADN error" message on a recent unit (firmware 3.00 and later): please refer to the dimmer’s
manual "Programming Digital Dimmers and NETBUS".

Hardware requirements for the PC
The minimum requirements for the PC and for an OnLine installation are:
• a PC, Pentium II or higher, 10/100 Mbit/s Ethernet card, CD reader, Win95/98/ME/NT/XP

operating system; 1024 x 768 monitor; a mouse and keyboard
• one NETPORT XT
• a hub/switch 10/100 Mbit/s
• standard Ethernet cables

Note: you can probably work without a hub/switch, and use a cross-link Ethernet cable
between the PC and the NETPORT XT. It is our experience that this usually works - but
we cannot guarantee it. Our tests have shown that success depends on the operation
of the Ethernet hardware in your PC, as well as on the Operating System in your PC.

Ethernet cable - maximum 100 m

REMINDER ! The maximum cable length (except for fiber optic cable) is 100 m between nodes:
• max. 100 m between PC and hub/switch
• max. 100 m between NETPORT XT and hub/switch
• max. 100 m between PC and NETPORT XT (cross-link)

The cable length includes the drop cable (from the PC or the NETPORT XT to the wall), the in-
the-wall cable (max. 90 m), and the patch cable between the wall socket and the hub.

WARNING! stick to the rules!

This limit is a timing issue. The longer the cable, the longer the signal needs to travel from end to
end, and back; respecting the maximum cable length is necessary for proper operation of the
Collision Prevention scheme.

For more information, and rules about the lay-out of an Ethernet network, please refer to
dedicated books or articles.

Display settings for the PC

Dimmer Manager is optimised for a display setting of 1024 x 768. When set to a lower setting,
the lower part of the window (including some buttons) may not be visible.
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Powering-up sequence

After all cables have been connected, we recommend the following power-up sequence: start
at the dimmers and work up towards the Dimmer Manager PC.
1. Dimmers
2. NETPORT XT
3. Hub/switch
4. Dimmer Manager PC

How can I find the IP address of a NETPORT XT

Each NETPORT XT leaves the factory with a factory-set fixed IP address. The standard factory
setting is 2.a.b.c where a.b.c are the three least significant bytes of the MAC address of the
NETPORT XT hardware.

The factory-set IP address is printed on the rear panel.

Alternatively, you can get a list of all the NETPORT XT present on the network by means of the
Scan Dimmers feature of Dimmer Manager. See Automatic discovery.

Note: NETPORT XT can be set to fixed IP addresses 2.1.2.21 or 192.168.0.21 by means of
specific internal settings (jumpers). For factory testing use only.

Note: the same applies to NETPORT.

Appendix E: touring racks with separate XLR5 “DMX only”
and “ADN only”

Many ADB Touring Dimmer Racks are fitted with two independent pairs of XLR5:
• one pair for “DMX only” (but with continuity of pin 4 and 5)
• one pair for “ADN only” (but with continuity of pin 2 and 3).

Subtlety: to obtain “DMX and ADN in the same DMX cable”, all you have to do is link DMX-only-
Out to ADN-only-In with a two-pair DMX cable.
Both remaining XLR5, DMX-only-In to ADN-only-Out now have DMX and ADN.

Example No. 1:
- NETPORT XT not used for DMX
- Tour rack 1 on universe A
- Tour rack 2 on universe B
- Both tour racks on ADN

Data cabling: daisy-chain from NETPORT XT to Rack 1 – ADN then to Rack 2 – ADN. The
sequence doesn’t matter.
DMX cabling: as usual.

Example No. 2:
- NETPORT XT not used for DMX
- Tour rack 1 on universe A and ADN
- MEMOPACK on universe A and ADN

Data cabling: daisy-chain from DMX console or splitter – NETPORT XT – Tour Rack1 DMX only
– Tour Rack 1 ADN only – MEMOPACK. The sequence doesn’t matter.
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Appendix F: testing Ethernet communication (ping)

Once a suitable IP address has been set for the Dimmer Manager PC, you can connect the
Ethernet cabling to the NETPORT XT and check whether they communicate. The ping function
provides a simple check; it is independent of the Dimmer Manager software.

Ethernet cabling (see the NETPORT XT manual for more information)
• or a cross-link Ethernet cable connecting the PC with one NETPORT XT
• or a hub or switch, connected to the PC and one or several NETPORT XT by means of

standard Ethernet cables

The ping function

The ping function tests the Ethernet communication between the PC and a node with known
IP address.

The factory-set IP address of a NETPORT or NETPORT XT is printed on its back.

If 2.a.b.c is the IP address of the target NETPORT XT.
• or: WindowsStart > Run
• or: WindowsStart > Programs > Command Prompt
• or: WindowsStart > Programs > Accessories > Command Prompt
• type ping 2.a.b.c
• click OK

Correct communication will give return messages:
Reply from 2.a.b.c
plus additional information about transmission duration times.

A communication failure will give a return message:
Request timed out.

What if the PC has a firewall ?

The firewall may block the outgoing ping.
Or the ping function may work but actual data exchange will not work.
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Appendix G: about changing IP settings

This paragraph is irrelevant if your PC is only used for off-line editing, or for viewing of the *.dim
files such as the sample (demo) file.

WARNING

Always consult your local IT staff. Please give them the information Required IP settings for the
PC. Any changes to network settings in the PC are at your own risk.

The following procedure uses an IP address (2.1.1.1) which is suitable when one Dimmer
Manager PC is networked with one or several NETPORT XT, without any other Ethernet node.

A network with other "lighting" nodes such as lighting consoles, Art-Net devices… requires
planning of all the IP addresses.

Use of ’alternative configuration’
You may have a Dimmer Manager PC which is dedicated to that function. Or the PC may also
be used for other tasks, such as office work, or a connection with the internet. This usually involves
connection to a non-lighting network with a DHCP server.

In that case you can set the PC to automatically works for both uses:
• when connected to the non-lighting network, the PC will automatically receive an IP address

from the network (DHCP).
• when connected to the Ethernet-for-lighting network, the PC will automatically use its

‘alternative connection’. You have to set that alternative connection to a fixed IP address
2.x.x.x as required to communicate with NEPTPORT/XT and NETPORT.

Start menu
Click on My Network Places
Click on View Network Connections
This opens the dialogue window: Network connections

In the category “LAN or High-speed connections”: double click on Local Area Connection
This opens the dialogue window: Local Area Connection status

Click Properties
This opens the dialogue window: Local Area Connection Properties

Tab: General
Select: TCP/IP
Then click: Properties

This opens the dialogue window: Internet Protocol (TCP/IP) Properties
Tab: Alternate Configuration
Select: User-configured
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Icon: Internet connections > Local area connection status

Changing IP settings in Windows XP
Step 1: you’ll check the current setting on your PC, and write it down.

WindowsStart > Settings > Control Panel > Icon: Network and Internet connections
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If the current setting is "Obtain an address automatically" then proceed with step 3.

Step 3: select the bullet: "Use the following IP address"

Step 4:IP address: enter an IP address, for example 2.1.1.1

Subnet Mask: 255.0.0.0

Click OK to close the window "Internet Protocol (TCP/IP) Properties".

Click OK to close the window "Local Area Connection Properties".

Close the window "Network Connections".

Select Internet Protocol (TCP/IP) and click Properties

This opens a dialogue window "Internet Protocol (TCP/IP) Properties".

Very Important: now make careful notes of the settings as they are. You may need these later
to restore the original configuration.

Step 2: setting required for communication with a NETPORT XT

If the current setting is "Use the following IP address" then go to step 4.

Click Properties. This opens a new window "Local Area Connection Properties"
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Changing IP settings in Windows 98

Step 1: check the current setting on your PC

WindowsStart > Settings > Control Panel and double-click on the Icon: Network

This opens a window "Network".

• double-click on the icon: TCP/IP->Network . This opens a dialogue window "TCP/IP
Properties".

• select the tab IP Address

Very Important: now make careful notes of the settings as they are. You may need these later
to restore the original configuration.

Step 2: we’ll now select the settings for communication with NETPORT XT

If the current setting is "Specify an IP address" then then go to step 4.

If the current setting is "Obtain an address automatically" then proceed with step 3.
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Click OK to close the window "Internet
Protocol (TCP/IP) Properties".
Click OK to close the window
"Network".
Close the window "Control Panel".

Step 3: select the bullet: "Specify an IP address".

Step 4: IP address: enter the IP address for the PC (in our example: 2.1.1.1)

Subnet Mask: 255.0.0.0
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Changing IP settings in Windows NT

Administrator privileges are required.

Step 1: write down the current settings

WindowsStart > Settings > Control Panel > Icon: Network > Tab: Protocols

• double-click on TCP/IP protocol. This opens the window "Microsoft TCP/IP Properties".
• select the tab "IP address"

Very Important: now make careful notes of the settings as they are. You may need these later
to restore the original situation.

Step 2 : we’ll now select the settings for communication with NETPORT XT

If the current setting is "Specify an IP address" then go to step 4.
If the current setting is "Obtain an address automatically" then proceed with step 3.

Step 3 : select the bullet: "Specify an IP address".

Step 4 : IP address: enter the IP address for the PC (in our example: 2.1.1.1)
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Subnet Mask: 255.0.0.0

Click OK to close the window "Microsoft TCP/IP Properties".
Click OK to close the window "Network".
Close the window "Control Panel".

Changing IP settings in Windows ME

Step 1: check the current setting on your PC

WindowsStart > Settings > Control Panel
• double-click on the Icon: Network
• double-click on the icon: TCP/IP->Network

This opens a dialogue window "TCP/IP Properties".
• select the tab IP Address

Very Important: now make careful notes of the settings as they are. You may need these later
to restore the original configuration.

Step 2: we’ll now select the settings for communication with NETPORT XT

If the current setting is "Specify an IP address" then then go to step 4.

If the current setting is "Obtain an address automatically" then proceed with step 3.

Step 3: select the bullet: "Specify an IP address".

Step 4: IP address: enter the IP address for the PC (in our example: 2.1.1.1)

Subnet Mask: 255.0.0.0

Click OK to close the window "Internet Protocol (TCP/IP) Properties".

Click OK to close the window "Network".

Close the window "Control Panel".
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Appendix H: updating the firmware in NETPORT (XT)
New firmware versions for NETPORT and NETPORT XT are available through ADB Distributors
and from the Internet. To check whether an upgrade is required, please compare the installed
firmware version with the latest version on the Internet.

Preparation for an update

1. You need the latest version of the firmware. The current URL of the download site is
http://www.adbttv.dyndns.org

The filename format is: ADN_20030515_V130.BIN You can store the file in the Dimmer
Manager folder.

2. You need an upload programme (rfu.exe) running on a PC.

The programme RFU.exe is included in the Installation package of Dimmer Manager.
Note: rfu.exe has succesfully been tested on Win XP and Win 98. We found that it does not
run succesfully on Win ME.

3. You need a cable to link the serial port of the PC to the NETPORT(XT).
at the PC end: DB9 receptacle (female)
at the NETPORT end: DB9 plug (male)

The wiring is one-to-one: pin 1 to pin 1, pin 2 to pin 2, ..., pin 9 to pin 9.

4. You need access to internal jumpers.

The internal jumper settings are:
- for standard use: W1 (label: Mode0) = OFF W2 (label: Mode1) = OFF
- while uploading firmware: W1 (label: Mode0) = ON W2 (label: Mode1) = ON

Practical steps to perform an update

Step 1: disconnect the dc power connector from NETPORT(XT). Remove the four screws of
the back panel.

Step 2: set jumpers W1 (label: Mode0) = ON and W2 (label: Mode1) = ON

Step 3: connect the DB9 cable to PC (COM x) and NETPORT(XT)

Step 4: connect the dc power connector

Step 5: on the PC: start the download programme "RFU.exe"

You’ll find it in the folder Dimmer Manager, or via the Start Menu:
WindowsStart > Programs > Dimmer Manager > RFU.exe

http://www.adbttv.dyndns.org
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Step 6 : in the menu, click  on Setup - Communication

This opens a dialogue window "Communications Options"
• tick "Use Serial Communication"
• Baud Rate: MUST be 57600
• Comm Port: select the available COM port on the PC  (COM1, COM2)

Step 7: this opens a dialogue window "Choose Loaders"

• Cold Loader: select "coldload.bin"
• Pilot BIOS: select "pilot.bin"
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Step 8: in the menu, click on File - Load Flash Image

This opens a dialogue window "Choose Flash Image"
• find and select the new firmware file (this example ADN_20030509_v103.bin)
• click OK

This starts the download, which takes approx. 10 seconds.

Note: there is no message to confirm a successful download.

Step 9 : set the internal jumpers back to the Standard position
W1 (label Mode0) = OFF     W2 (label Mode1) = OFF

Step 10: disconnect the DB9 cable; mount the rear panel.

Step 11: check that the firmware upload was successful.

To verify the firmware version of a NETPORT XT: in OnLine mode, Menu Bar > NETPORT XT
Manager > column / parameter Release.
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Additional sources of information

The User Manual for the dimmers

The comprehensive user manual for the dimmers, "Programming Digital Dimmers and NETBUS"
can be downloaded from the ADB website. http://www.adblighting.com > ADB Products >
Dimmers > "Programming Digital Dimmers and NETBUS" > and select the language.

The ADB Ethernet Network Guide

The "ADB Ethernet Network Guide" can be downloaded from the ADB website.
http://www.adblighting.com > ADB Products > Interfaces > Ethernet > select the User Manual.

The User Manual for NETPORT (XT)

The User Manual for NETPORT and NETPORT XT is available from the ADB website.
http://www.adblighting.com > ADB Products > Interfaces > NETPORT(XT) > select the User
Manual.

The DMX512/1990 standard

The text of the DMX512/1990 standard is available from the United States Institute for Theatre
Technologies (USITT) http://www.usitt.org and from the Professional Light and Sound Association
(PLASA) http://www.plasa.org.

Ongoing projects about DMX
http://www.usitt.org and http://www.esta.org/tsp/

ESTA and its Technical Standards Programme

Learn more about - or participate in - the ongoing standards development efforts:
http://www.esta.org/tsp/
Example: the ESTA Control Protocols Working Group covers subjects such as

DMX512-A the future successor to DMX512/1990
RDM Remote Device Management (EIA-485 serial transmission)
ACN Advanced Control Network (over Ethernet).

The process of creating a new standard includes one or several Public Reviews. Participate!

http://www.adblighting.com
http://www.adblighting.com
http://www.adblighting.com
http://www.usitt.org
http://www.plasa.org
http://www.usitt.org
http://www.esta.org/tsp/
http://www.esta.org/tsp/


Dimmer Manager software

Instruction Manual - page 68
Issue: 004 Lighting Technologies

Table of contents
Chapter 1: installing the Dimmer Manager  software 2
To Install the software 2
To Uninstall the software

Chapter 2: getting started – the demo version 3
Starting the Dimmer Manager software 3
Off-line User Levels 4
Menu bar description 4

Chapter 3: the Edit Parameters functions 7
Name of the dimmer unit 8
NETPORT XT 8
If DMX fails 8
Priority 8
Configuring DMX A - Patch 8
List of dimmers in the unit 8

Chapter 4: the Edit Patch functions 10
Getting to the Edit Patch functions 10
The Get and Send buttons 10
Patch A 10
House Patch A 11
Patch B and House Patch B 11
Dimmer Law 11
You can copy settings from one dimmer unit to another 11
Factor 12
Smoothing 12
Dimmer Name - adding text to a dimmer channel 13
Example of a Dimmer Name: the channel number 13
Example of a Dimmer Name: the DMX address and the DMX universe 13
Example of a Dimmer Name: its position or function 13
The Edit Patch Window for EURODIM Twin Tech 14

Chapter 5: Getting started – the on-line version 15
IP settings 15
Required IP settings for the PC 15
Changing the User Level when OnLine 16
Automatic discovery 16
Get FROM dimmers and Send TO dimmers 17
Local changes on the dimmers 17
Updating after you changed NETPORTs, dimmers… 17
Removing a NETPORT XT 17
Adding a NETPORT XT 18
Adding a dimmer unit 18
Deleting a dimmer unit - automatically 19

Chapter 6: the Test and Flash functions 20
Getting to the Test and Flash functions 20
Dimmer Test 20
Test and automatic Test Chaser 21
Shortcut to Change Patch 21
Dimmer Flash 21
Flash and automatic Flash Chaser 21
Shortcut to Change Patch 21
Test a Channel (use of Dimmer Name) 22
Dimmers having similar names 22



Dimmer Manager software

Instruction Manual - page 69
Issue: 004Lighting Technologies

Alternative automatic Test Chaser 23

Chapter 7: Learn Show, Learn – Scan – View Loads 24
Learn Show 24
Learn Show – manual mode 24
Learn show - shortcuts for manual selection 24
Learn Show – automatic mode using DMX (grab) 25
Adjusting the threshold level 26
Learn Loads 26
Scan Loads 27
Learn Loads or Scan Loads of one dimmer 28
View Loads 28
Clear Loads 28
How to manually set learn values 29

Chapter 8: status and error reporting 30
The four coloured flags in the icons 30
Overview of all the error messages - direct access 30
The three colours 30
The coloured flags 30
The four families of events 31
The Global (Default) Error Filter 31
How to edit the Global (Default) Error Filter 32
Ignore local changes on the dimmer units 32
How to edit the Error Filter for a dimmer unit 33
A coloured flag in a group icon – what does it mean 34

Chapter 9: Customized Global Overview Lists 35
How can I get an overview of patch, factors and dimmer laws ? 35
How can I get an overview of patch and House patch ? 35
How can I get an overview of the contents of the local memories ? 35
How can I get an overview of "What happens when DMX fails ?" 35
How can I see whether multiple dimmers are set to the same DMX address ? 35
How do I perform a query ? 35
Sorting of the results 36
How do I create a new custome query ? 37

Chapter 10 : Creating a virtual dimmer system (off-line) 38
Preliminary notes 38
Creating a virtual NETPORT XT 38
Creating a virtual group 39
Creating a virtual dimmer unit 40
Creating a virtual dimmer system 41
Making virtual clones 42

Chapter 11: FAQ – frequently asked questions 44
How do I change the configuration which appears at start-up 44
Using CTRL and SHIFT to select multiple dimmer units 44
Using CTRL to unselect dimmer units 44
What does the shaded grey cross mean ? 44
What does the red cross mean ? 44
System-Wide play Memory Control Panel - How can I put Names in the Buttons 44

Glossary 45

Appendix A: How to distribute DMX and DMX+ADN 47
The DMX patch panel 47
The DMX splitter 47
Outgoing lines with DMX 47
Outgoing lines with DMX+ADN 47



Dimmer Manager software

Instruction Manual - page 70
Issue: 004 Lighting Technologies

DMX generated by a conventional console (without ArtDMX) 47

Appendix B: Data line termination 48
Situation A: Independent ADN cables 48
Situation B: DMX+ADN cables - DMX generated by a console 49
Situation C: DMX+ADN cables - DMX generated by the NETPORT XT 50

Appendix C: Preparing and testing an ADN network 51
Why does NETPORT XT also have XLR5-M connectors ? 51
Setting the Network Address of the dimmer units 51
How many dimmer units can I connect to one NETPORT XT 51
With two NETPORT XT you can use the same Network Address twice 52
Check that the cable type is correct 52
Check that data pairs stay together 52
Check all the extension cables 52
Non-ADB equipment: check the continuity of the second data pair 52
Use of NETBUS and Dimmer Manager 52

Appendix D: Troubleshooting an ADN network 53
Your first check 53
Check for non-ADN signals 53
Use the "Master of…" function in the dimmers 53
What can I learn from the error messages ? 53
Dimmer firmware requirements 54
Older dimmer firmware and "MODBUS error" or "ADN error" messages 54
Hardware requirements for the PC 54
Ethernet cable - maximum 100 m 54
Display settings for the PC 54
Powering-up sequence 55
How can I find the IP address of a NETPORT XT 55

Appendix E: Touring Racks with separate XLR5 "DMX only" and "ADN only" 55

Appendix F: testing Ethernet communication (ping) 56
The ping function 56
What if the PC has a firewall ? 56

Appendix G: about changing IP settings 57
Changing IP settings in Windows XP 58
Changing IP settings in Windows 98 60
Changing IP settings in Windows NT 62
Changing IP settings in Windows ME 63

Appendix H: updating the firmware in NETPORT (XT) 64
Preparation for an update 64
Practical steps to perform an update 64

Additional sources of informations 67
The User Manual for the dimmers 67
The ADB Ethernet Network Guide 67
The User Manual for NETPORT (XT) 67
The DMX512/1990 standard 67
Ongoing projects about DMX 67
ESTA and its Technical Standards Programme 67





Belgium N.V. ADB-TTV Technologies S.A.
(Group Headquarters) Leuvensesteenweg 585, B-1930 Zaventem
Tel : 32.2.709.32.11, Fax : 32.2.709.32.80, E-Mail : adb@adblighting.com

Deutschland ADB GmbH Boschstrasse 3, D-61239 Ober-Mörlen
Tel : 49.6002.93.933.0, Fax : 49.6002.93.933.33, E-Mail : info@adblighting.de

France ADB S.A.S. Sales Office: 168/170, boulevard Camélinat  F-92240 Malakoff
Tel : 33.1.41.17.48.50, Fax : 33.1.42.53.54.76, E-Mail : adb.fr@adblighting.com

Factory & Group Logistics Centre: Zone industrielle Rouvroy F-02100 Saint-Quentin
Tel : 33.3.23.06.35.70, Fax : 33.3.23.67.66.56, E-Mail : adb.fr@adblighting.com M

-3
00

3-
E

-0
8l

ADB - Your Partner for Light

Lighting Technologies

S
ub

je
ct

 t
o 

m
od

ifi
ca

t io
ns

www.adblighting.com




